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Don't Forget the Area Code

Modem users of WGM normally receive the software preset with at least one icon for a 
Worldgroup service.    To make sure long-distance callers get the correct number, this icon 
almost always includes a full telephone number: 1+areacode+number.    If this Worldgroup is
a local call to you, however, you need to edit the icon's properties to erase the 1+areacode 
before you can use it.    

To do this, highlight the icon, pull down WGM's File Menu, and select Properties.    On the 
window which then appears, look at the How To Connect area for the field Phone # and 
make sure it is correct for you.    

Does your telephone line require you to dial 9, or some other access code, before dialing an 
outside number?    If so, add that code to the Phone # field.    For example: 95837808

Must there be a pause after the access code before dialing the outside number?    If so, type 
a comma where the pause is needed in the Phone # field.    For example: 9,5837808

If you do not see a Phone # field, it is because this icon is currently set to contact the 
Worldgroup server through a network or a direct serial cable connection.    Consult the Sysop 
or your LAN administrator before making changes.    



What is Worldgroup?

In the same way cars are an extension of people's legs, Worldgroup is an extension of 
people's voices and writing hands.    Through Worldgroup online services, people can 
exchange messages and computer files with each other whether they are in the same office 
or on the far side of the planet.    

A Worldgroup online service can provide at least:    

E-mail for delivering private messages and files between individuals,    
Forums for posting public messages arranged in threads of conversation, 
Teleconference for live typing sessions which range from quiet chats to boisterous town 

meetings, and 
Libraries of program and document files for users to read online or copy down to 

their PCs.    

Through Worldgroup, remote callers aren't remote anymore.    They can leave messages on 
others' desks (E-mail), post announcements or comments in the hallway (Forums), enter a 
conference room for a planning session (Teleconference), retrieve the newest revision of 
company documents and other work-in-progress, and submit their contributions to the work 
(Libraries).    Worldgroup can be an electronic post office, a file library, a forum for public 
debate, even an electronic town meeting.    

On the lighter side, Worldgroup can be a social gathering place where people mingle without
leaving home. It can be an online nightclub where users visit for hours at a time or for just a 
few minutes.    

You may be familiar with national services such as America Online, CompuServe, GEnie, 
Prodigy, MCI Mail, and Delphi.    And then there's the Internet.    Many online services are 
available today. 

What's different about the average Worldgroup is that it isn't overwhelmingly huge.    For 
every service supporting 200 simultaneous callers, there are a thousand smaller systems 
offering specialized services to just a handful of callers at a time.    

On a Worldgroup system, you're not a number.    You can either use your own name or make 
up a handle.    Name a subject, any subject, and there's a Worldgroup out there discussing it. 
A Worldgroup system can help you find the people, and the information, you're looking for.    

Galacticomm maintains a telephone list of Worldgroups whose owners wish to publicly 
advertise their services.    This list is available on our Demonstration System.    You're 
welcome to contact DemoSys at any time via modem at (305) 583-7808 (USA).    More and 
more Worldgroups offer Internet connectivity.    Through them, or through other Internet 
service providers, you can also reach DemoSys via telnet and ftp at gcomm.com

See also What is Worldgroup Manager (WGM)? 



What is Worldgroup Manager (WGM)?

WGM is a program which connects you to any online service running Worldgroup server 
software by Galacticomm, Inc.    

When you contact an online service running Worldgroup, WGM will operate as a full-featured 
Windows application.    Through WGM, you can look up information on other users in 
Registry, exchange messages with them in E-mail and Forums, participate in live debates in 
Teleconference, and browse through documents and programs available for download in File 
Libraries.    The Sysop of each system will likely provide other functions as well.    

When you contact an online service running a version of Galacticomm's The Major BBS 
(Worldgroup's predecessor), or another brand of BBS software, WGM will operate as a 
traditional, text-based terminal program.    Your interactions with BBSes will appear as a flow 
of text scrolling across your screen, possibly with ANSI graphics.    The concept is very similar
to running DOS in a window.    

See also What is Client/Server (C/S)? and Accessing Terminal Mode BBSes.    



What is Client/Server (C/S)?

Client/server means that one program (the client) can ask another program (the server) for 
assistance.    The two programs often run on separate computers connected by a 
communications link (a network, the telephone system, etc.).    

WGM is a client program
It runs on your PC.    It does not need to be in contact with an online service to do 
many tasks (such as letting you compose    e-mail messages).    Only when you ask it 
to do something it cannot do alone (such as delivering those messages to other 
users) does WGM call for assistance.    

Worldgroup is a server program
It runs on a remote computer and serves client programs which call it.    It handles 
centralized tasks such as exchanging messages from client to client and maintaining 
master copies of documents, programs, and other files.    

BBSes are not servers    
WGM can communicate with many non-Worldgroup online services, just not in 
client/server mode.    In particular, WGM can communicate with systems running The 
Major BBS (Worldgroup's predecessor).    When WGM encounters a BBS, it drops back 
from C/S mode to terminal mode in order to communicate with it.    

C/S mode saves time and money
WGM can do a lot of valuable things while on deck.    For example, you can write as 
many E-mail messages as you wish before ever going online.    Just put them in your 
Out Box.    At this point, using WGM costs you only as much per minute as using your 
word processor program (presumably nothing).    

Once you do go online, you'll spend most of your time clicking on this button, 
pressing that key, and typing an occasional word.    Maybe a sentence every now and 
then.    The connection between your PC and the online service's PC, though, can 
carry hundreds if not thousands of times more traffic.    WGM takes maximum 
advantage of the connection's bandwidth by performing many tasks at once.    

For example, all of those E-mail messages you composed will be uploaded to the 
server PC's hard disk.    Mail addressed to you is likewise downloaded to your hard 
disk.    At the same time two dozen E-mail messages automatically come and go 
behind the scenes, you're free to browse through files in a library or participate in a 
teleconference.    

Further, WGM operates like a chess player: when it presents you with a choice among
several options (like a menu), it knows you'll take at least a fraction of a second to 
make your decision.    While you're deciding, WGM tries to anticipate your response: it
begins requesting from the server what it thinks you're about to ask for.    

WGM even updates itself automatically.    

If your connection is over a long-distance telephone line, C/S will save you money.    



No matter what connection you have, C/S will save you time.    

See also Accessing Terminal Mode BBSes.    



WGM Updates Itself

WGM and the applications it runs are designed modularly.    Like Windows' Program Manager,
it manages groups of icons, and each icon calls an individual Worldgroup system.    When you
first installed WGM, it most likely came with one service icon (for the server from which you 
received the WGM installation).    

WGM is by no means limited to the online service from which you received it.    You can 
create new online service objects in WGM and use them to contact as many different 
systems as you wish.    If you have more than one form of connection on your PC (modem, 
LAN cable, etc.), you can use the same copy of WGM to reach out through any of them.    

Every time you use WGM to contact a Worldgroup system and select an application, WGM 
will check to see whether your PC's hard disk already holds the necessary client-side 
application files.    If so, WGM immediately runs the app.    If not, it immediately starts 
downloading the files, then runs it.    

You don't have to suggest a file transfer protocol.    You don't have to create a subdirectory 
for it on your hard disk.    You don't have to edit any .INI files.    In fact, you shouldn't try to do
any of these things because WGM is self-governing and changing it from the outside causes 
damage.    

As time goes on, it's quite possible your PC's hard disk may contain several different 
revisions of, say, the Registry module.    This will be because you've contacted at least one 
Worldgroup service running the first revision of Registry, at least one more running the 
second revision, and so forth.    You won't need to keep track of any of this, however: WGM 
will update each application module for each system independently as it sees the need.    

While downloading is going on, you are welcome to move the status window into the 
background and continue with other activities.    Of course, if you go into a high-traffic 
application such as Teleconference, you'll compete with the download and it will take longer 
than if you had gone into a lower-traffic area such as E-mail.    

Perhaps once or twice a year, you'll encounter a Worldgroup system which also has a newer 
version of the management module.    Before downloading, WGM will ask you for permission 
to update itself.    Depending on the speed of the connection between your PC and the 
Worldgroup server, this may take quite a few minutes.    

You are always free to say no, to prevent WGM from updating itself.    If the differences 
between your revision and the state of the art are minor, you will be able to use your version
to converse with this Worldgroup server.    If the differences are substantial, however, your 
version will not work with the newer server.    In such cases, WGM will permit you to say no 
but will tell you that it cannot communicate with this system until and unless you let it 
update.    

You may be confident that newer versions of WGM's management module will be backwards 
compatible with online services still running older revisions of the Worldgroup server 
software.    After all, the WGM management module you presently have is backwards 
compatible with BBSes still running Galacticomm's The Major BBS (in terminal mode).    This 
is a trend we intend to continue.    

Unless you have an overriding reason to say no, then, it's to your great advantage to permit 
WGM to keep itself up to date.    



See also No User-Serviceable Parts.    



No User-Serviceable Parts

When you first installed WGM, it suggested it place itself in the subdirectory \WGMAN but 
offered you the opportunity to place it elsewhere.    All help topics assume that you did 
accept \WGMAN.    

WGM's files are extremely interwoven and cross-referenced in order to support self-updating 
and client/server.    WGM does not contain user-editable .INI files and changes should only be
made through WGM itself.    Do not use outside programs to hand-edit any part of WGM or 
move it to another location in the directory structure.    

If you do hand-edit the contents of any file in \WGMAN or its subdirectories, or if you delete 
or move any, the change may not be immediately fatal to WGM.    It will, however, cause 
unpredictable side-effects which most likely will remain with you until you completely 
delete \WGMAN's subdirectory tree and reinstall from scratch.    

How DOS sees WGM's file structure
The directory \WGMAN contains the program and data files for the management 
module of WGM.    The file \WGMAN\GCSLOCAL.DAT (for Galacticomm client/server 
Local Data file) contains the names and paths of all client-side application files which 
WGM receives from each Worldgroup system you contact, plus other basic 
information.    It acts as the hub, the master record, in WGM's data file structure.    

When you contact a Worldgroup system, WGM creates a subdirectory under \WGMAN 
for data directly pertaining to that system.    

When you first run a client app (E-mail, File Libraries, etc.), WGM creates a 
subdirectory under \WGMAN for that application and stores all client-side files 
pertaining to it there.    As you contact more Worldgroup systems and ask for the 
same activity from each, WGM will check its local subdirectory to see if it already has 
the appropriate version of the client-side app.    If so, it cross-references and 
immediately runs the application without requiring a repeat download.    

When WGM encounters a system running a newer server-side version of the 
application, WGM will download the newer client app and store it in the same 
subdirectory as the older versions.    Older versions are not discarded in favor of new, 
however.    One system running a new revision doesn't mean that all Worldgroup 
systems have made the upgrade.    WGM keeps client-side versions in sync with 
server-side versions for each system you contact.    

How WGM sees its own file structure
The file \WGMAN\GCSLOCAL.DAT plus any support files in the \WGMAN tree which 
were imported from a Worldgroup system are what we call the Primary and 
Secondary Caches.    

This is why hand-editing at the DOS level is so devastating: although DOS and/or 
Windows will show you a directory tree containing dozens of seemingly independent 
program and data files, WGM views the entire structure as one massive data file with 
GCSLOCAL.DAT at its core.    Change any part of WGM from the outside and 
everything will come out of sync.    

Similarly, even though File Manager will show many files in the \WGMAN tree which 



end in .EXE, they are not independent programs.    They rely on WGM to provide an 
operating environment and do not operate properly in isolation.    



Automating WGM

You can create an icon in Windows' Program Manager which will load WGM and immediately 
go on deck or online to one of its services.    You can even put this icon into Program 
Manager's Startup group.    

First, run WGM and write down the precise spelling, including spaces, of the label under the 
service icon you wish to automatically run from Program Manager.    For example, most of our
PCs have a service icon in WGM labeled Galacticomm Demo System.    Once you've written 
down the label, exit out of WGM.    

Bring up Windows' Program Manager, highlight the Worldgroup Manager icon, and press F8 
to make a copy of the icon.    It's important to leave an original copy of the Worldgroup 
Manager icon so that you can get to WGM itself.    

Highlight the new icon and press Alt-Enter or pull down Program Manager's File menu and 
select Properties.    The Program Item Properties window will appear.    

The first field, Description, is the label text which appears under this icon.    At the moment, 
it says Worldgroup Manager.    You'll probably want to change it to the name of the service 
you're planning to automate.    For example, some of the PCs in our offices have Program 
Manager icons labeled DemoSys Now.    These go immediately online to Galacticomm's 
Demo System.    

The second field, Command Line, is the program which is run when you double-click this 
icon.    At the moment, it says C:\WGMAN\GCSVCMAN.EXE unless you told WGM's installation 
program to use a different directory.    

Place the cursor at the end of whatever is written in Command Line, press Space, then type 
in the exact text of the label under the service icon you wish to automatically run.    For 
example, some of the PCs in our offices have icons with the command line C:\WGMAN\
GCSVCMAN.EXE Galacticomm Demo System

Click OK to save these changes, then double-click on your new Program Manager icon.    The 
WGM "Loading" icon should appear at the bottom of your screen but the Worldgroup 
Manager window should not come up.    If the service icon you've automated is one which 
immediately goes online, the Connecting to... window will appear.    If the service icon you've
automated is one which takes you on deck first, the Main System Menu window will appear.   

When you exit from the Main System Menu, WGM closes without ever bringing up the 
Worldgroup Manager window.    This is why you should keep an original copy of the WGM icon
which runs GCSVCMAN.EXE without any command line parameters.    

By the way, it appears that Windows' Control Panel has this same functionality.    For 
example, the Command Line CONTROL.EXE COLOR immediately brings up the Color window. 
When you exit Color, you exit Control Panel.    

Back to WGM, in the event you wish to immediately run one service but then drop back to 
the Worldgroup Manager window, add to the end of Command Line the parameter /NOEXIT

You can place a WGM icon, automated or not, in Program Manager's Startup group and it will
automatically run whenever you start Windows.    For example, some of us put our DemoSys 
Now icons in Startup so we always go online immediately.    Even on some of our remote PCs,
a DemoSys On Deck icon lets us write e-mail and forum messages offline, etc.    





File Menu

New
Creates a new online service object: a group or an item (icon).    

Open
Runs the currently highlighted online service item (icon), has the same effect as 
double-clicking on it or pressing Enter.    

Move
Moves the currently highlighted online service item (icon) to another group.    

Copy
Creates a duplicate of the currently highlighted online service item (icon).    

Delete
Erases the currently highlighted online service item after asking "Are you sure?"    

Properties
Edits the currently highlighted online service item (icon), displaying the same window
in which you first created the Item (New).    

Exit
Closes the WGM program, shutting down any online connection.    



Online Service Objects

Each online service you contact will appear within WGM as an icon in a group.    Icons and 
groups are Online Service Objects.    

To create a new Online Service Object, go to the File menu and select New.    

Online Service Group
WGM is organized in a manner similar to Windows' Program Manager: icons must be 
contained in groups.    There must be at least one Online Service Group.    You can 
create as many groups as you wish, sorting your service icons by pay vs. free, by 
local vs. long distance, by LAN vs. modem, or in any other way you wish.    

Online Service Item
WGM is organized in a manner similar to Windows' Program Manager: an icon 
activates an individual program.    In WGM's case, an icon activates the client-side 
program of an individual online service.    

When you first receive WGM, it may already contain one group and one icon.    This icon will 
connect you with the service from which you received WGM.    You are free to create more 
icons, in this group or in another you create, for other online services you wish to access.    
You create new groups and icons through WGM's File menu by selecting New.    



Online Service Group Properties

This lets you create a new online service group.    

To reach this window, go to the File menu and select New, click once on Online Service 
Group, then click OK.    

You are being asked to provide a text title, and a file name, for a new group in WGM.    This 
group will be able to contain icons (online service items), each of which can connect to a 
particular Worldgroup, BBS, or other online service.    

Think of it in terms of Windows' Program Manager: common groups there include Main, 
Startup, and Accessories.    Common groups in WGM include Modem, Network, Local, Long 
Distance, Free to the Public, and Charge for Use.    

Description
What you type here will be displayed in one of three places: under the group's icon 
while the group is minimized, on the title bar of the group when it is restored, and on 
WGM's title bar when the group is maximized.    

Group File
You can specify a name (up to 8 characters) for the file on your hard disk which will 
store the information about this group.    Don't try to specify a path.    If you don't 
specify a name at all, WGM will use part of the description as a file name.    



Online Service Properties (Item)

This is where you provide the information WGM needs in order to connect to a particular 
Worldgroup, BBS, or other online service.    

To create a new service icon in an Online Service Group, go to the File menu and select New. 

To edit an existing service icon in an Online Service Group, first highlight the icon.    Next, go 
to the File menu and select Properties.    Alternatively, you can press Alt-Enter.    

Name
This is the name of the online service you'll be contacting through this icon.    You may
type whatever descriptive phrase you wish here but, since this will be the title under 
an icon, brief is best.    

When to connect
Do you want WGM to immediately attempt to contact this Worldgroup server the 
moment you double-click on its service icon, or would you prefer to run offline and 
make contact with the server later?    

To reach this window, first run Worldgroup Manager, then highlight the icon of the 
service you wish to edit.    Next, pull down WGM's File menu and select Properties.    
Alternatively, you can press Alt-Enter.    
Always connect upon invoking this service
This means your PC will immediately attempt to contact the online service as soon as
you double-click on this icon.    If you are using WGM to connect to a Worldgroup 
server via an office LAN, direct serial connection, or via a local phone number to a 
service which does not limit or charge your time online, this is probably the best 
choice.    

Also, if you are using WGM to contact a BBS or other non-Worldgroup online service, 
select this choice.    There is no such thing as on deck when using terminal-mode 
systems.    
Run offline until "Connect" button is pressed 
This means that double-clicking on the service's icon will first take you on deck but 
not yet online.    If you are using WGM to connect to a service which limits or charges 
for your time online, especially if the service is a long distance call to you, this choice 
will let you do many tasks while offline and not incurring charges.    

This setting does not prevent WGM from attempting to go online whenever you ask it 
to perform a task which requires server assistance.    For example, if you ask for a list 
of users currently online, WGM does not have that information so it will attempt to 
connect to the server in order to get that information.    You can stop an attempt to 
connect by clicking the Disconnect button on the Status Window.    

When making its first call to a new Worldgroup server, this service icon will 
immediately attempt to connect because it does not yet know what its menus are 
supposed to look like while on deck.    

How to connect



WGM can connect to online services over a modem, through a direct serial cable 
connection between your PC and the server's PC, over a Novell LAN, or by a direct 
connection to the Internet.    Each icon in WGM can record one way to connect to one 
server.    In our offices, for example, we can connect to our Worldgroup server by 
modem and also by Novell LAN.    Our copies of WGM are set up with two icons: one 
to connect by modem, and another to connect by LAN.    

To reach this window, first run Worldgroup Manager, then highlight the icon of the 
service you wish to edit.    Next, pull down WGM's File menu and select Properties.    
Alternatively, you can press Alt-Enter.    
Modem    &    Phone#    &    Settings
For connecting to an online service via a modem.    
It makes no difference whether the modem is internal, or whether it's external and 
connected to your PC through a serial port.    If a modem is involved, select this 
option.    

Phone# is the telephone number that will be dialed when you double-click on this 
icon.    Be sure to include all necessary digits (leading 1 if long distance, area code, 
etc.).    Standard formatting is permitted: 1 (305) 583-7808 is acceptable, although 
13055837808 is all that's really necessary.    
Note: a comma in this string inserts a half-second pause in the dialing sequence.    For
example: 9,583-7808 inserts a pause after the access code (the 9) before dialing the 
rest of the number.    
Modem configuration options are entered in Settings.    
Serial    &    Settings
For connecting to an online service via a direct serial cable.    This is a common way to
connect user PCs which are within a few hundred feet of the Worldgroup server PC 
when a network is not available.    This has nothing to do with modem connections.    
Serial port configuration options are entered in Settings.    
Novell LAN    &    Server name
For connecting to an online service via Novell SPX on a local area network.    
Server name is the name by which your office's Worldgroup identifies itself through 
Novell's Server Advertising Protocol (SAP).    The dropdown list will display all servers 
currently advertising on the network.    Consult your LAN Administrator.    
Telnet    &    Host name
For connecting to an online service via a direct TCP/IP connection to the Internet.    
Host name is the name by which the Worldgroup server identifies itself to other 
equipment on the network (for example, demosys.gcomm.com).    Host name can also
accept a numeric address (for example, 199.227.15.16).    Finally, you can follow the 
host name or numeric address with a space and a port number if this online service is
located on any port other than the telnet default.    Consult your network 
administrator or host service provider on all of these issues.    

How to log on
To reach this window, first run Worldgroup Manager, then highlight the icon of the 
service you wish to edit.    Next, pull down WGM's File menu and select Properties.    
Alternatively, you can press Alt-Enter.    
Log on as new user
If you already have a user account on this online service, uncheck this box and fill in 
the User-ID and Password fields below.    



If you do not have a user account on this online service, make sure this box is 
checked.    When you next contact the service, WGM will log onto it as "New".    The 
service will then ask you a series of sign-up questions ending with which User-ID and 
password you'd like to be known by.    The sign-up process will automatically uncheck 
this box and insert the User-ID and password you've selected in the appropriate 
fields.    
User-ID
If you already have a user account on this online service, uncheck the Log on as new 
user box and type in your User-ID here.    
Password
If you already have a user account on this online service, uncheck the Log on as new 
user box and type in your password here.    

Alternatively, you can leave the User-ID and/or Password fields blank here and the 
program will prompt you for the information each time you attempt to contact this 
Worldgroup server.    
Advanced...
Auto-sensing and dial-timeout issues are set in Advanced Logon Parameters.    You 
may never need to change settings in this area.    



Modem Settings

This window is used to set up the connection between your PC and your modem.    

To reach this window, go to the Options menu and select Modem Settings.    You can reach 
this same window through the Settings button in the Properties window of every online 
service item (icon) you create.    

Despite so many ways to reach this window, there is only one record in all of WGM for 
Modem Settings.    This is because you will be using the same modem no matter which online
service(s) you choose to contact via modem / telephone line.    

Even if yours is an external modem cabled to one of your PC's serial ports, pay no attention 
to the areas of WGM marked "Serial" or "Direct Serial."    These refer to running a serial cable
from a user's PC directly to a Worldgroup server PC in the same office.    Every setting you'll 
need to make for a modem connection will be found in areas marked "Modem."    

COM Port
On which of your PC's serial ports should WGM expect to find a modem?    Internal 
modems act electronically as if they were external modems cabled to a COM port, so 
this question needs to be answered for any sort of modem.    
External Modems
Almost every PC arrives from the factory with a COM1 serial port and socket.    Most 
have a COM2 as well.    A few will have COM3 and even COM4.    Any of the four will 
work with an external modem.    To identify which socket is which COM port, consult 
your hardware documentation.    
Internal Modems
Almost all internal modems can be jumpered to act as COM1 or COM2.    A few can 
also be set to act as COM3 or COM4.    Your modem's manual will describe this.    
There must be only one device per port, however: if you set your internal modem to, 
say, COM1, you'll need to turn off the COM1 serial port which is built into the PC.    If 
you bought the PC with the modem already installed, this has probably already been 
taken care of.    
Interrupts (IRQs)
IRQs are circuits which demand the PC's attention when new information arrives 
(someone moved the mouse, the modem just received some data from the online 
service, etc.).    WGM does require the use of an interrupt in modem connections, so it
is very important that no other devices try to use the modem's interrupt.      Typically, 
devices on COM3 attempt to use COM1's interrupt.    That is, a mouse on COM1 will 
likely cause trouble for a modem on COM3.    Devices on COM2 likewise share an 
interrupt with COM4.    Consult your hardware manuals and/or hardware supplier if in 
doubt.    

Modem Brand
This lists every brand of PC modem for which we know settings.    If your modem does
not appear on the list, scroll to the top and select the Generic model whose speed is 
closest to yours, then try it out.    If problems arise (trouble connecting, trouble 
remaining connected, lots of retries, etc.), come back to this window and choose 
Options....    



Modem Setting Options

This is where you can manually tweak settings for your modem instead of relying on the 
Modem Brand list in Modem Settings.    You can also use it to view the list's suggested 
settings without making any changes.    

To reach this window, go to the Options menu and select Modem Settings.    Next, on the 
Modem Settings window, click the Options button.    

Baud Rate
What you're setting here is
the fastest speed (in bits 
per second) at which your 
PC and your modem can 
accurately talk to each 
other.    This applies to both
internal and external 
modems.    If your modem 
supports data 
compression, you can set 
your DTE/DCE segment's 
baud rate to as much as 
twice the stated baud rate 
of the modem.    

Don't be concerned about 
the speed expected by the 
online service: your 
modem and the service's 
modem will negotiate to 
find the fastest speed both 
can accurately use 
(DCE/DCE segment).    

Lock modem speed
Should the baud rate between your PC and your modem (DTE/DCE segment) stay the
same even if your modem and the service's modem (DCE/DCE segment) negotiate a 
different speed?    

If your modem has data compression, it's normally best to lock the baud rate 
between your PC and your modem... the box should be checked.    

If your modem does not have data compression (most 2400 bauds, some older 9600 
bauds), it's normally best to let the baud rate between your PC and your modem drop
to the speed negotiated by the two modems... the box should be unchecked.    

This setting must agree with the command you give your modem in Initialization 
String.    

Dial Mode
Select Tone unless your phone line only supports pulse (old-style rotary click) dialing.  



Initialization String
This is the series of commands which WGM will send to your modem at the beginning
of any modem session.    When you selected a modem in the Modem Brand field of 
the Modem Settings window, it inserted this suggested initialization string here.    If 
the suggested string works, don't change it.    

If you must change it, however, have your modem manual in hand as you check each
one of the following commands.    Most modem manufacturers adhere to the Hayes 
AT command set standard, but only up to a point.    Some emphasize the ampersand 
(&), some the backslash (\), and others use entirely different commands.    When in 
doubt, trust your modem's manual.    

Here are two good starting points for init strings plus an explanation of each 
individual command and why it is there.    Be aware that your modem could have 
different commands for these features:    

AT&FE0S0=0S2=255X1&C1&D2&K3&Q5&B1
or

AT&FE0S0=0S2=255X1&C1&D2\Q3\N3\J0

Almost all Hayes-compatible modems understand the following list of commands, and
WGM needs these commands in the init string of any modem which is to connect with
a Worldgroup server or a Major BBS:

AT Begins most commands to the 
modem, including init strings.    

&F Returns modem settings to factory 
defaults (starts from scratch).    

E0 Tells the modem not to echo back 
any data it receives from your PC 
(characters coming from the modem 
will then be either modem status 
messages or data from the online 
service's modem).    

S0=0 Tells the modem not to answer when 
it senses a ring signal from the phone
line.    

X1 Tells the modem to give status 
messages to the PC for CONNECT 
speeds as well as the basic RING, NO 
CARRIER, etc.

&C1 Carrier Detect (CD) is an RS-232 
signal which your modem can send 
to your PC.    This command tells the 
modem to turn on CD only when it's 
actually in contact with another 
modem, and turn CD off when the 
connection is broken.    

&D2 Data Terminal Ready (DTR) is a signal
which your PC can send to your 



modem.    This command tells the 
modem to terminate the phone 
connection (hang up) whenever your 
PC turns off DTR.    

Different modem brands may have different names for these next commands.    If you
don't find an exact match in your modem's instructions, use the commands which 
come closest to performing the same functions.    

&K3 
or \Q3
or 
&R0

This is usually called RTS/CTS or 
Hardware Flow Control.    
Request To Send (RTS) is a signal 
which your PC sends to your modem 
when the PC is ready to receive data 
from the modem.    The modem must 
be set to send data to your PC only 
when RTS is turned on (the PC turns 
RTS off when it's busy so data won't 
be lost).    
Clear To Send (CTS)    is a signal 
which your modem sends to your PC 
when the modem is ready to receive 
data from the PC.    Usually, the 
above command also tells the 
modem to turn CTS on and off as 
necessary to keep the PC from 
swamping it with data.    If it's two 
separate commands on your modem,
be sure to include both.    

&Q5 
or \N3
or \N9

Tells your modem to negotiate with 
the online service's modem the 
fastest but most reliable connection 
speed possible.    This will 
automatically enable V.42 / MNP-5 
data compression and error 
correction if available in both 
modems.    

&B1 
or \J0

Tells your modem to lock the speed 
of the DTE segment between your PC
and itself.    If your modem does not 
have data compression, you probably
do not want to give it this command. 
In fact, it may not have such a 
command at all.    
Make sure that this is in agreement 
with the Lock modem speed option 
on the Modem Setting Options 
window of WGM.    Either lock both 
sides, or leave both sides unlocked.    
Otherwise, you'll have a modem 
talking at one speed to a PC listening
at another speed... the result will be 



garbage.        
W2 Tells the modem to report DCE speed

(negotiated phone connection speed)
instead of locked DTE speed when it 
reports CONNECT 9600, CONNECT 
2400, etc.    Non-compressing 
modems (and even some 
compression-capable models) do not 
have this command.    



Modem
A device which translates data between two methods of communication, historically 
between serial and telephone communications.    The word is short for MOdulator-
DEModulator because telephone modems transmit across phone lines by modulating audible
tones.    

External Modem

The modem circuitry is housed in its own cabinet outside the PC and is connected 
to the PC by a straight-through serial cable to one of the PC's COM ports.    

Internal Modem

The modem circuitry shares a PC card with the COM port circuitry, thus hiding the 
serial part of the connection inside the PC's cabinet.    

PCMCIA Modem
 Most notebook computers on the market today offer PCMCIA slots for extremely 

compact add-on devices including modems.    The modem circuitry is housed in a package 
barely larger than a credit card.    

Both external and internal modems connect to the telephone system by a standard RJ11 
phone cord.    Most PCMCIA modems also provide connectivity to cellular telephones.    



RJ11 Telephone connector

 RJ11 (also known as modular) is the standard for single-line telephone equipment
in North America.    The telephone company does not see any substantial difference between
a telephone for humans and a modem for computers.    The same RJ11 cord which connects 
your telephone to your wall jack will successfully connect a modem to the wall jack.    



Direct Serial Connection Settings

If you are setting up a modem / telephone line connection to an online service, pay no 
attention to this window.    Nothing you enter here will have any effect on a modem 
connection.    This window is used to set up a direct serial cable connection between two PCs 
in the same office, one a user's PC and the other the Worldgroup server's PC.    

To reach this window, go to the Options menu and select Direct Serial Settings.    You can 
reach this same window through the Settings button in the Properties window of every online
service item (icon) you create.    

Despite multiple ways of reaching this window, there is only one record in all of WGM for 
Direct Serial Settings.    

COM Port
On which of your PC's serial ports should WGM expect to find a direct serial 
connection to a Worldgroup server PC?    Almost every PC arrives from the factory 
with a COM1 serial port and socket.    Most have a COM2 as well.    A few will have 
COM3 and even COM4.    Any of the four will work with a direct serial connection.    To 
identify which socket is which COM port, consult your hardware documentation.    
Interrupts (IRQs)
IRQs are circuits which demand the PC's attention when new information arrives 
(someone moved the mouse, the COM port just received some data from the online 
service, etc.).    WGM does require the use of an interrupt in direct serial connections, 
so it is very important that no other devices try to use the serial port's interrupt.      
Typically, devices on COM3 attempt to use COM1's interrupt.    That is, a mouse on 
COM1 will likely cause trouble for a direct serial connection on COM3.    Devices on 
COM2 likewise share an interrupt with COM4.    Consult your hardware manuals and/or
hardware supplier if in doubt.    

Baud Rate
This sets the speed (in bits per second) at which the COM Port will broadcast and 
receive.    Both the user's PC and the online service's PC need to be talking at the 
same speed.    

A null-modem serial cable less than 50 feet (15 meters) in length should have no 
problem carrying 38,400, but many PC serial ports under Windows do not operate 
properly at speeds faster than 9600 baud.    Also, the longer the cable run, the lower 
the optimum speed.    Start high and, if you encounter data losses or too many 
retries, work your way down in speed.    



Serial Port Sockets
PC serial ports may be connected to external modems via straight-through cables, directly to
other PCs via null-modem cables, or to non-communications devices such as mice.    There 
are two North American standard socket types for PC serial ports:

 DE9 (also known as DB9) sockets are found on almost all notebook PCs.    Many full-
cabinet PCs now come with at least one DE9 as well.    They will always be male on the PC 
(pins, not holes).    One or two brands of external modems have DE9 sockets as well, always 
female (holes, not pins).    

 DB25 sockets are the broad industry standard and pre-date PCs by many years.  
Almost all external modems have DB25 female (holes, not pins) sockets, and many PCs have
them as well, always male (pins, not holes).    

Thanks to a regrettable design decision from 1980, PC parallel printer ports also use the 
DB25 socket type but are completely incompatible with serial ports.    The one advantage is 
that PC parallel ports are always female and PC serial ports are always male.    



Null-modem Cables
These are serial cables wired so as to hoodwink two computers into thinking there are 
modems in between them.    WGM requires null-modem cables only for direct serial 
connections between users' PCs and a Worldgroup server PC in the same office.    They are 
not used for modem connections.    

Modems are data communications equipment (DCE).    PCs are data terminal equipment 
(DTE).    

A modem's DCE serial socket is wired partially backwards from a PC's DTE serial socket.    
This allows a straight-through cable to connect the PC's transmit pin to the modem's receive 
pin, and vice versa.    

To properly connect two PCs (two DTE devices), the cable between them must have some of 
its pins reversed in order to fake being a pair of modems.    

There are three wiring schematics appropriate to direct serial connections involving WGM:

DB25-to-DB25 Null-Modem Cable 
DB25-to-DE9 Null-Modem Cable 
DE9-to-DE9 Null-Modem Cable 



DB25-to-DB25 Null-Modem Cable



DB25-to-DE9 Null-Modem Cable



DE9-to-DE9 Null-Modem Cable



Straight-through Cables
These are serial cables wired so that Pin #1 at one end is connected to Pin #1 at the other 
end, Pin #2 to Pin #2, and so forth, for all pins in the cable.    

Straight-through cables are used between PCs and modems.    

Null-modem cables are used in direct serial  connections between two PCs.    



Advanced Logon Parameters

To reach this window, go to the Online Service Properties window and click on the Advanced 
button in the How to log on section.    

Auto-sense client/server
When a Worldgroup system answers an incoming call, it sends out a special signal 
which asks if the caller wants to connect in C/S mode.    

With this box checked, WGM answers YES and initiates a C/S-mode connection.    

If you wish to force WGM to connect with a Worldgroup system in terminal mode, 
uncheck this box.      

A non-Worldgroup system will not ask the question and so will provide only a 
terminal-mode connection.    

Auto-sense ANSI
If the online service is a Worldgroup system and the Auto-sense client/server question
box is checked, this option has no effect.    

With this box checked, WGM will answer YES when a terminal-mode BBS asks if your 
software supports ANSI graphics.    If you want a raw (ASCII) text connection to a BBS, 
uncheck this box.    Where possible, though, leave it checked.    

Dial timeout
This sets the number of seconds WGM will wait between telling the modem to begin 
dialing and receiving a CONNECT signal from the modem.    In some situations, you 
may find that the factory setting is too long.    When dialing to remote areas, though, 
you may find that you need to extend the timeout.    

Auto-sense timeout
This sets the maximum number of seconds WGM will wait for Worldgroup to send its 
"Do you want C/S mode?" query.    If you uncheck the Auto-sense client/server box 
above, however, WGM will skip the step.    10 seconds is the shortest period of time 
you should give this option.    In some cases, you may need to give it more time.    



Move Online Service Item

This moves an online service item from one online service group to another.    

With a mouse:
Click on the icon you wish to move, drag it to its new group, then release the mouse 
button.    

Through the pulldown menus:
1) before selecting any menu options, click once on the icon you wish to move.    
2) go to the File menu and select Move.    In the Move Online Service Item window, 
confirm that the phrase beside "Move Online Service Item:" is the label of the icon 
you wish to move.    Also confirm that the phrase beside "From Online Service Group:"
is the label of the group which currently contains the icon.    
3) Under "To Group:", click on the down arrow and select the group you wish to move 
the icon to.    
4) click on OK



Copy Online Service Item

This makes a duplicate copy of an online service item in the same, or another, online service
group.    

To copy an item:
1) before selecting any menu options, click once on the icon you wish to duplicate.    
2) go to the File menu and select Copy.    In the Copy Online Service Item window, 
confirm that the phrase beside "Copy Online Service Item:" is the label of the icon 
you wish to copy.    Also confirm that the phrase beside "From Online Service Group:" 
is the label of the group which currently contains the icon.    
3) Under "To Group:", click on the down arrow and select the group you wish to copy 
the duplicate icon to.    It is acceptable to create a copy within the same group.    
4) click on OK

Note that this is an independent item which for now just happens to have the same settings 
as its original.    It is not a clone.    It is not a linked copy.    Edits made to one will not affect 
the other.    You'll use Copy most often to save retyping time when you create an item for a 
new online service similar to one you already have: you'll make a copy, make a few minor 
adjustments like a different phone number, and you'll be done.    



Delete Online Service Object

This erases the currently highlighted Online Service Item (icon) and the Properties record 
associated with it.    This will also erase an Online Service Group if it contains no items 
(icons).    

To reach this window, first highlight the Online Service Object you wish to remove.    Next, go 
to the File menu and select Delete.    Alternatively, press the Del key.    

Read the question in the Delete window CAREFULLY to be sure you are in fact deleting what
you think you are deleting.    

Are you sure?
Yes
The object will be erased.    There is no "undo" once you say yes.    
No
The object will remain intact and you will return to WGM's main window.    



Options Menu

Auto Arrange
If checked, this will automatically align icons within groups using the same horizontal 
and vertical measurements used by Windows' Program Manager.    

If not checked, you are free to place icons in whatever orientation you wish.    

Minimize on Use
If checked, WGM will minimize to an icon as soon as you open (run, double-click) one 
of its online service items (icons).    It will reappear when you exit from that service 
(double-click the Main System Menu's control menu ).    

If not checked, WGM will remain an open window while you are on deck and/or online.    WGM
will on occasion move on top of the service's main menu window (for example, to tell you 
that it's received a two-minute warning before the online service disconnects you).    In 
general, it's better to leave Minimize on Use checked.    

Save Settings on Exit
If checked, as you exit WGM the program will record the layout of icons and groups.    
When next run, WGM will come up with the same layout.    

If not checked, WGM will not record the current layout on exit.    When next run, WGM 
will come up with the layout it had when you last exited with a checked Save Settings
on Exit.    

Modem Settings...
This is where you configure the connection between your PC and your modem, 
including COM port settings for a modem.    

Direct Serial Settings...
This is where you configure a direct serial cable connection (no modems) from your 
PC to a nearby Worldgroup server.    This has no bearing on a modem connection.    

Storage Settings...
You can adjust the amount of hard disk storage area WGM has available for programs 
and data, and set whether (and how long) to retain partially received files from 
interrupted downloads.    

Compress...
This utility removes obsolete client-side files from your hard disk and optimizes both 
caches.    



Storage Settings

This is where you set limits on how much of your PC's hard disk space WGM can use for 
temporary data (and client-side program) storage.    You can also set whether (and how long)
to retain partial downloads which were interrupted.    

To reach this window, go to the Options menu and select Storage Settings.    

From this window, you can adjust the amount of disk space WGM uses for memory 
management on your PC:    

Secondary Cache
In computer terms, a "cache" is a temporary resting place, or scratchpad, for data.    
When you look up a telephone number and write it on a scrap of paper, the paper is a
cache: it is not meant to be a permanent record, but rather a convenient time saver.   
WGM's secondary cache behaves in this manner.    

Every time you request information from a Worldgroup system, the transmission 
takes time and increases traffic over the connection.    If you ask again for the data 
and it hasn't changed, it would be a waste of time for the system to send it to you 
again.    The secondary cache temporarily holds such data on your PC's hard disk, 
freeing the connection to deliver one-time-only data such as incoming or outgoing E-
mail messages.    

Say you request a list of currently online users from a particular Worldgroup system.   
The first thing WGM does is check to see if you yourself are online.    If you are simply 
on deck, WGM will take you online to the Worldgroup server.    Next, WGM will 
examine the file \WGMAN\GCSLOCAL.DAT to see if there is such a list already in the 
secondary cache.    If there is, WGM sends to the server a request for a list, plus a CRC
checksum of the list WGM already has.    When the server receives the request, it 
examines the checksum to see if the current list of users online is identical to the list 
WGM already has.    If the two are different, the server downloads the new list to 
WGM.    If nothing has changed, the server tells WGM that the existing list in WGM's 
secondary cache is still valid.    

The secondary cache's data is not accessible to you while you are offline.    It is used 
solely for efficient data exchange while you are online.    Since the secondary cache 
contains data such as the list of users currently online, when you yourself are not 
online this is not meaningful information.    

You can test to see if the secondary cache is set too small by asking for the same list 
(Registry's, perhaps) several times in a row.    The first time you ask for the list, note 
roughly how long it takes to appear.    Then ask for it again.    If WGM displays the list 
almost instantly, the secondary cache is probably large enough.    

Check one more thing first, though: the secondary cache's Bytes In Use readout.    If 
Bytes In Use is at or near Maximum Bytes, increasing the secondary cache's 
Maximum Bytes will improve performance.    If Bytes in use is nowhere near Maximum
Bytes, it may simply be that your PC's connection to the Worldgroup server is almost 
as fast as your PC's connection to its own hard disk.    At that point, you might 
consider another kind of cache: a disk cache governed by your PC's operating 
system.    Consult your DOS and/or Windows manuals for more details.    



Primary Cache
It may at first seem inappropriate to describe the primary cache's contents as 
temporary.    The primary cache contains programs as well as data, and both may 
remain on your hard disk for years until erased at your request or replaced by newer 
information.    

Better analogy: your office is your primary cache for your paperwork in progress.    
There's no sense walking down to the filing room to look up the same file eleven 
times every day.    It's so much easier to make a copy of the file and keep it in your 
office until you're finished with it (or at least until you run out of desk space).    Three 
years from now, you'll have long since discarded your copies, but the filing room will 
still have the originals.    In this case, it is appropriate to describe long time periods as
temporary.    

WGM's primary cache is its office and each Worldgroup system is a distant file room.   
While it makes sense to download a new revision of, say, the Registry application, it 
makes no sense to download the same version every time you want to look 
somebody up.    

The primary cache is what permits you to work on deck.    Free space permitting, the 
more of your PC's hard disk you can allocate to the primary cache, the more efficient 
your online and on deck sessions will be.    This is especially true if you use WGM to 
contact many different Worldgroup systems.    Terminal-mode BBSes don't count 
because WGM can't run any part of them locally... if it could, they wouldn't be 
terminal mode.    

See also No User-Serviceable Parts and Compress cache and local data file.    

Save aborted file downloads for possible resume
File downloads can be interrupted for several reasons: you can intentionally abort a 
download, the Worldgroup server can automatically abort a download if your time 
online reaches its session or daily limit, or a noisy line, power blink, etc., can break 
the connection between your PC and the Worldgroup server.    

If this box is checked, 
WGM will save a partially received file to a temporary filename within the \WGMAN 
directory structure.    If you reconnect within Save for X days, and download the file 
again, WGM will pick up where it left off instead of starting over.    

Addendum to Murphy's Law: at least once in your life, you'll be 27 minutes into a 30 
minute download and lose the connection.    If this box is checked, you don't have to 
start over from the beginning.    

If this box is unchecked, 
WGM will delete partial downloads immediately after the transfer is interrupted.    
When you download the file again, WGM will begin at the beginning.    

Save for X days
This is the number of days WGM will hold temporary files created by aborted 
downloads.    Once this number of days passes without another attempt to download 
the same file(s), the temporary file(s) may be deleted.    





Compress cache and local data file

This function optimizes the contents of the primary and secondary caches: the core data 
file \WGMAN\GCSLOCAL.DAT plus the entire subdirectory\file structure under \WGMAN.    

To reach this window, go to the Options menu and select Compress.    

When you delete an Online Service Item (icon) from WGM's main menu, WGM does not 
automatically erase the subdirectories or the files associated with it.    This is left for the 
Compress function.    

Compress does not discard any information which is still in use.    It does erase files in the \
WGMAN subtree which are clearly obsolete, and it frees up unused space in the core data 
file.    

To optimize your caches, then, click on Compress.    Depending on the Maximum Bytes 
settings of both caches, and the speed of your computer, this may take several minutes.    

See also No User-Serviceable Parts.    



Sign-up and Log-on

Sign up
To identify yourself to an online service for the first time, creating your own user 
account, User-ID, and password.    

If you have already signed up on a particular Worldgroup server, you do not need to 
sign up again just because you are now using WGM.    If you are asked to sign up 
when you first contact the server through WGM, exit from Sign-up and edit the icon's 
Properties.    

Log on
To identify yourself to an online service with an existing User-ID and password and be 
welcomed in.    

Log off
To tell an online service that you are disconnecting from it... a polite exit. 

Session
The period from logging on and logging off.    Some systems limit the length of online 
sessions, rationing access so that all users have a fair chance at reaching an 
available line.    In-house and networked systems usually do not place limits on 
session times because the intent is to keep everyone connected at all times.    

For more specific information, enter the module and select its Help menu.    Contents is the 
best starting point for browsing.    Search for Help on... is the best starting point if you have a
particular subject or keyword in mind.    



Logging On

If you did not specify a User-ID or password in Online Service Properties, and if you left the 
Log on as new user box unchecked there, this window will appear whenever you attempt to 
go online.    

To reach this window, first run Worldgroup Manager, then attempt to connect with a 
Worldgroup server by double-clicking on its service icon.      

Log on as new user
If you already have a user account on this online service, make sure this box is 
unchecked and fill in the User-ID and Password fields below.    

If you do not yet have a user account on this Worldgroup server, make sure this box 
is checked.    When you contact the service, WGM will log onto it as "New".    The 
service will then ask you a series of sign-up questions ending with which User-ID and 
password you'd like to be known by.    

User-ID
If you already have a user account on this Worldgroup server, uncheck the Log on as 
new user box and type in your User-ID here.    

Password
If you already have a user account on this Worldgroup server, uncheck the Log on as 
new user box and type in your password here.    



Accounting

Through your user account, an online service can track the amount of time you are online 
with it, and can track some of the activities you do while online: how many (and what size) 
files you download, how many e-mail messages you send, etc.    

Many systems use this information solely for marketing purposes, to see what's popular so 
they can provide more of it.    Services are free of charge and are limited only by the needs 
of other users to get the same access you do.    Most government-sponsored systems fall into
this group, as do a large number of business-sponsored ones.    Such businesses use their 
systems to promote their products or services, and generally make their names known.    

Other companies use accounting information to charge for the use of their services.    In 
these cases, the online service is the business.    Often, for-profit systems will permit you to 
sign up as a prospect or applicant, allowing you to have a peek without charging.    It may 
seem strange to pay for something that you can get free elsewhere, but can you?    Many for-
profit systems provide valuable services not found on public boards.    

Some online services are completely private, in-house boards which are used as the next 
step up from network e-mail systems.    In these cases, accounting information is used to 
measure traffic flow on the system.    

For more specific information on a particular online service, enter its Account Display/Edit 
module and select its Help menu.    Contents is the best starting point for browsing.    Search 
for Help on... is the best starting point if you have a particular subject or keyword in mind.    



Registry

Registry is a voluntary list of at least some of the users of a particular online service.    You 
can use Registry to look up information on other users, and let other users look you up.    
When you create your own Registry entry, you are free to answer N/A to any question which 
you would prefer not to answer.    

Since this information is specific to each system, Registry answers are stored on the 
Worldgroup server's PC (or BBS PC), not on your PC.    This means that you'll need to be 
online to do most things in Registry.    

Not all online services use the Registry module.    Some do not feel the need for a user 
identification area.    Others prefer a more comprehensive "yellow pages" approach via such 
add-ons as The Major Database.    

You need to be online to perform most activities in Registry.    

For more specific information, enter the Registry of Users module and select its Help menu.   
Contents is the best starting point for browsing.    Search for Help on... is the best starting 
point if you have a particular subject or keyword in mind.    



E-mail

Electronic mail is a powerful and efficient way to send detailed messages to individuals who 
need not be there when the message arrives.    Messages can also deliver attached 
document or program files, a major improvement over transferring files by floppy disk.    

E-mail has become a common service on local area networks (LANs) in businesses.    It is also
common on wide area systems such as the Internet and CompuServe.    The two areas 
evolved independently, however, and are only now starting to share messages with each 
other.    Many existing e-mail systems have been slow to acknowledge the value of 
connecting with each other.    

Worldgroup provides e-mail service to LAN workstation users and remote PC modem users 
through the same onscreen interface, WGM.    

If your company already uses a LAN-based e-mail system which is Novell MHS-compatible 
(cc:Mail, Microsoft Mail, plus many others), Worldgroup can be easily configured to exchange
messages between users on that system and users on Worldgroup.    

With additional software and equipment on the server side, Worldgroup can be configured to
exchange messages with e-mail services in the internetwork area, allowing you to exchange 
e-mail messages with people across the world.    

You need to be online when getting new mail messages and when sending messages you've 
written.    You do not need to be online to do any other task in E-mail.    

When you get new mail, those messages are always copied from the server down to the In 
Box on your PC.    Once they arrive, you can read them regardless of whether you are online 
or offline.    

When you write mail, those messages are recorded in the Out Box on your PC and are not 
transmitted to the server until you explicitly send them.    You do not need to be in contact 
with the server while composing mail messages.    

For more specific information, enter the E-mail module and select its Help menu.    Contents 
is the best starting point for browsing.    Search for Help on... is the best starting point if you 
have a particular subject or keyword in mind.    



Forums

Forums are typically long-term conversations.    One user will start a topic of discussion by 
posting a question or a comment (I feel this way about X.... How does everyone else feel 
about it?).    Other users will read the message the next time they are online.    Some will 
reply to the message.    Replies to replies may continue over a period of weeks or months, 
the thread of conversation often becoming many hundreds of messages long.    

Threads are valuable sources of information even if you don't wish to participate in the 
debate.    You'll read all sides of an issue and gain a much fuller understanding from it.    In a 
technical support forum, for example, a thread might start with one user describing a 
problem she's having by posting a request for advice.    She may get 17 responses that night,
some of them contradictory.    There may well be more than one solution to the problem, and
even the wrong ones can show what not to do.    By the next night, others will have chimed 
in to naysay the inaccurate suggestions.    

Forums are also known as newsgroups, and a much older term for them was SIGs.    They all 
mean roughly the same thing.    Newsgroups is a term most often associated with the 
Internet, while Forums is the more common term in the BBS community.    Now with 
Worldgroup, the two can intermingle: Internet newsgroups can be made to appear exactly as
if they were forums on your Worldgroup system.    

You can use Forums in a fully-online or in a batch-offline mode.    If online time is not 
expensive to you, you can browse forums while online, type replies to them while online, etc.
If online time is expensive to you, however, you can copy messages which interest you to an
In Box on your PC, go offline, and read those messages on deck.    You can write replies to 
those messages, holding them temporarily in an Out Box on your PC.    When you are 
finished writing, you can go online just long enough to send those replies to the forum(s).    

For more specific information, enter the Forums module and select its Help menu.    Contents
is the best starting point for browsing.    Search for Help on... is the best starting point if you 
have a particular subject or keyword in mind.    



Teleconference

A teleconference is a rapid-fire version of a forum.    Replies are immediate, and often come 
from half a dozen users at once.    While past comments in a forum may linger for months, 
teleconference comments last only so long as voices echo in a conference room.    

As in Forums, there may be many conversations going on at once on separate channels 
("rooms") in Teleconference.    Often a forum discussion blossoms into a teleconference, or 
vice versa.    In general, if you are able to watch a teleconference, you are welcome to 
participate in it.    

You'll need to be online to perform most activities in Teleconference.    After all, the whole 
point of a teleconference is to be live and online with other users.    

For more specific information, enter the Teleconference module and select its Help menu.    
Contents is the best starting point for browsing.    Search for Help on... is the best starting 
point if you have a particular subject or keyword in mind.    



File Libraries

Many online services provide document and program files which you can download to your 
PC.    Some systems may charge for the privilege of copying their files.    Others are happy to 
let you download for hours at no charge.    

A single Worldgroup system may offer several gigabytes (1024 megs) of files, usually 
categorized by subject into separate libraries.    When you browse a library, you'll typically 
find brief descriptions by each file, helping you locate items of interest.    

You'll need to be online when you actually download (or upload) files.    You'll also need to be 
online when you request lists of available files.    It is possible, though, for you to save file 
listings in special (.gfl) files on your PC and examine them offline later.    You can read the 
file descriptions in those saved lists, and tag files which you wish to download later.    When 
you've finished studying the saved lists, you can go online just long enough to download all 
the files you've tagged.    

For more specific information, enter the File Libraries module and select its Help menu.    
Contents is the best starting point for browsing.    Search for Help on... is the best starting 
point if you have a particular subject or keyword in mind.    



Information File Pages

Each Worldgroup system (or BBS, or other online service) will have its own way of doing 
things.    Information file pages are a common way to let you read documents explaining 
what services a particular system offers, possibly the cost of those services, and general 
rules of the road.    

You'll need to be online to view file pages because they are stored on the server, not on your
PC.    

For more specific information, bring up an Information File Page and select its Help menu.    
Contents is the best starting point for browsing.    Search for Help on... is the best starting 
point if you have a particular subject or keyword in mind.    



Polls and Questionnaires

Online services are among the most powerful consensus-finding tools ever invented.    They 
permit individuals scattered across the planet to come to an electronic "town meeting" and 
let their concerns be heard.    While Teleconference and Forums offer a dynamic exchange of 
commentary, they are not well suited to measurement.    Polls and Questionnaires offer users
the chance to vote, and offer system operators the chance to get hard facts on voter 
sentiment.    

Businesses use Ps & Qs to find out how customers feel and what they want.    Social groups 
use Ps & Qs to find out the same information from members.    

Some systems even pay you to vote.    In return for filling out a poll or a questionnaire, you 
could receive extra file download privileges, extra time online, or other forms of persuasion.   

You'll need to be online to perform most activities in Polls & Questionnaires.    

For more specific information, enter the Polls and Questionnaires module and select its Help 
menu.    Contents is the best starting point for browsing.    Search for Help on... is the best 
starting point if you have a particular subject or keyword in mind.    



Doors

Doors are DOS programs running on PCs at the Worldgroup server's site which you can run 
remotely through Worldgroup.    Since door programs are written by companies apart from 
Galacticomm, they cannot establish C/S-mode connections with WGM.    When you enter a 
door, WGM automatically downshifts to terminal mode, putting all in-progress activities on 
hold.    WGM will resume client/server communications when you exit the door.    

For more specific information, see Terminal Mode Options Menu.      



Accessing Terminal-Mode BBSes

WGM is capable of communicating with BBSes running versions of Galacticomm's The Major 
BBS.    WGM is also capable of communicating with some non-Galacticomm BBSes.    It 
connects to these systems in terminal mode, not C/S mode, of course, since their software 
was not written specifically for a client/server environment.    

You create an icon for a terminal-mode BBS in the same way you create one for a C/S-mode 
Worldgroup system (see Online Service Properties (Item)).    When WGM determines that the 
BBS cannot support client/server, WGM displays the Terminal Mode window and the BBS's 
text begins appearing within it.    

Once you are online with a Major BBS (or a Worldgroup if you choose to contact it in terminal
mode), help is available by typing ? Enter at most prompts.    Non-Galacticomm online 
services will likely have different methods of providing help.    

Some facets of a Worldgroup server may be terminal-mode also.    The most common 
example is Doors, which permit you to access DOS programs running on a PC at the 
service's office as if they were running on your own PC.    Because they are DOS programs, 
they have no capacity to handle a C/S-mode connection.    While you are in a Door, you are in
terminal mode.    Once you exit a Door, the connection is restored to C/S mode.    

The Terminal Mode window of WGM provides interface functions for handling such things as 
file transfers.    See Terminal Mode File Menu and Terminal Mode Options Menu 



Terminal Mode File Menu

This menu appears on the Terminal Mode window which displays the text exchanged 
between your PC and a terminal-mode BBS.    

Download
When a terminal-mode BBS is attempting to download a file to you, select this option 
to receive the file.    

Upload
When a terminal-mode BBS is awaiting a file upload from you, select this option to 
send the file.    

Exit
Closes the Terminal Mode window, shutting down any online connection.    



Download using a file transfer protocol

Where on your PC do you want to place the file which this terminal-mode BBS is attempting 
to send you?    

To reach this window, from the Terminal Mode window's File menu, select Download.    

Directories
Double-click on a directory to switch to it.    If the directory you seek is not visible, 
double-click on its parent.    This list box does not display the entire tree at once, but 
limits itself instead to the parentage and children of the current directory.    

The current directory is the one whose folder icon is open and darkened within.    Any 
folders listed below it are children subdirectories of the current directory.    Any folders
listed above it are parent directories.    Between the list box and the title line 
Directories: you will see displayed in text the current directory's drive:\path, 
possibly abbreviated.    

Drives
This dropdown list box selects the drive letter you wish displayed.    Depending on 
your PC's setup, it may display volume names in [brackets] to the right of each drive 
letter.    

A single click selects a drive letter.    The Directories and File Name list boxes will 
change to display the new drive's current directory and files.    

File Name
In some file transfer protocols (ZMODEM, for example), this section of the window will
not appear because the protocol will deliver to your PC both the contents of the file 
and its name as it is known on the terminal-mode BBS.    

In other file transfer protocols (XMODEM, for example), you will need to specify a 
filename to which to save the downloaded file.    You can manually enter the entire 
drive:\directory\...\filename.ext in this field if you wish.    

If you are able to type in the filename.ext, make sure the extension you choose is the
same as the file has on the BBS.    For example, if the file is labeled <something>.zip on
the BBS, it's most likely been compressed using PKZIP.    Even if you save it to 
<something>.bat on your PC, the file itself will still be a zip and you'll have to explain 
the unexpected extension (.bat) to PKUNZIP in order to uncompress the file.    

The standard list box below the text box displays all files in the current drive:\
directory.    This helps you avoid name collisions.    

Of course, you may want to save the new file over top of an existing file.    In that 
case, double-click on the file you wish to overwrite.    

Protocol
This button lets you select which terminal-mode file transfer protocol you wish to use 



when downloading the file from the BBS PC to your PC.    



Terminal-mode File Transfer Protocol

It's often appropriate to transfer the contents of entire files between your PC and an online 
service.    You can attach files to E-mail or Forums messages, for example, and add or 
retrieve files in File Libraries.    

In order to assure that what arrives on one machine matches what departed the other 
machine, both PCs must first agree on a common file transfer protocol.    

When dealing with a Worldgroup system in client/server mode, files are transferred in the 
same manner as are all other exchanges of data: through Dynapaks.    While using WGM to 
work with a Worldgroup server, you will not need to consider anything in this help topic.    

When dealing with a BBS in terminal mode, however, there are a number of commonly 
encountered file transfer protocols:    

ZMODEM is the best choice for BBSes running on DOS PCs
ZMODEM (resume) can pick up at the point where a previous ZMODEM transfer was 

interrupted
YMODEM Batch is a good alternative if the BBS does not offer ZMODEM
Kermit/SuperKermit is useful when contacting BBSes which are not DOS PC-based
XMODEM-1K is acceptable on connections with low line noise
XMODEM-CRC is tolerable on connections with high line noise
XMODEM-Checksum is the weakest of the accuracy-checking methods
ASCII has no accuracy checking and should be a last resort only

For a more in-depth explanation of these protocols, see Understanding File Transfer Protocols



Understanding File Transfer Protocols

In brief: use ZMODEM if at all possible, Kermit/SuperKermit or YMODEM-Batch in the absence
of ZMODEM, and XMODEM only if you have to.    See also Terminal-mode File Transfer 
Protocol. 

ASCII (continuous dump)
This is the simplest, and also the least reliable, file transfer protocol.    Whatever raw 
text crosses the channel, including line noise, is placed into the file.    No attempt is 
made to confirm that what arrives at the destination matches what departed the 
sender.    Avoid using it unless there is no other alternative.    

Listing (a Screen at a Time)
This protocol sends the contents of a text file to a user's PC a screenful at a time.    
It's a way for you to read a file without needing to copy it to your PC's hard disk.    
That's why it is not included as an option in the Terminal Mode File Transfer Protocol 
window: it's for your eyes only.    

XMODEM-Checksum
This is one of the earliest and most widely used file transfer protocols for 
microcomputers.    It can transmit any file composed of 8-bit bytes.    XMODEM detects
transmission errors by sending a 1-byte checksum character with each block of data 
sent, and corrects errors by resending the block which failed its checksum test.    

The size of a file transferred by XMODEM is always a multiple of 128 bytes.    That's 
because XMODEM transmits a file in blocks of 128 characters and has no way of 
conveying the actual amount of data in the last block.    When a file is transferred 
using XMODEM, the unused portion of the last block is filled with ASCII End Of File 
characters (CTRL+Z).    

XMODEM-CRC
This variation of XMODEM-Checksum uses a more accurate 2-byte Cyclic Redundancy
Check instead of a simple 1-byte checksum.    With this protocol, it is less likely that 
random line noise will be mistaken for good data (the odds are about one in a 
hundred thousand with CRC versus one in only a few hundred with Checksum).    

XMODEM-1K
This variation of XMODEM-CRC uses 1024-byte blocks instead of 128-byte blocks.    
On channels with little or no line noise, this can increase efficiency.    That's mainly 
due to the turnaround delays associated with XMODEM: send a block, wait for 
acknowledge, send another block, wait for acknowledge.    These delays occur one 
eighth as often when sending 1024 bytes at a time instead of 128.    Some interfaces, 
particularly X.25 packet-switching networks, have very long turnaround delays.    

On channels with high line noise, however, the smaller blocks of 128-byte XMODEM-
CRC are usually more efficient.    When just one byte in a block fails to agree with its 
CRC, the block must be sent again.    Resending a 1024-byte block takes as long as 
resending eight 128-byte blocks.    



The size of files downloaded with XMODEM-1K may be a multiple of 128 bytes, not 
1024, because the final bytes of the file may be transmitted in 128-byte blocks.    

YMODEM Batch
This protocol takes the best of XMODEM and adds some significant improvements:    

Multiple files can be sent in one transfer session

File names are communicated

Exact file sizes are communicated

The file's time and date are communicated

Not all these features are used in every case.    Files attached to E-Mail and Forums 
messages must still be transferred one file at a time, for example.    It is also up to the
sender to put the file name in the message's topic field when uploading file 
attachments.    

YMODEM-g
This protocol assumes there is zero probability of transmission errors and transmits 
an entire file without stopping to wait for acknowledgement of each 1024-byte block. 
If there are transmission errors, the receiving party will detect them and end the 
transfer immediately.    It is something of a step backwards, especially when used with
compression-capable modems.    Use YMODEM Batch instead.    

ZMODEM
ZMODEM is the most efficient terminal-mode file transfer protocol so far.    It is also 
the most complex because it was written to deal with a wide range of data 
communications requirements.    ZMODEM adds to YMODEM-batch's multi-file and 
name/size/datestamp abilities these additional benefits:    

Streaming: the sender stops sending only when the receiver complains

Interrupted transfers can be resumed in a later file transfer session

Packet-switching network idiosyncracies are taken into account

Checks to see if the receiver already has the file(s) and, if so, if the receiver's 
copy is newer/larger than the one queued for transfer

ZMODEM is a streaming protocol that usually defaults to an infinite window (block) 
size.    This means that transmission will continue nonstop unless the receiver reports 
an error.    Transfers are at their most reliable, however, when the window size in the 
terminal program is set to a finite value such as 2048 (0 usually represents infinite 
window size).    This value is set by the terminal-mode BBS.    

A 2048-byte window size means that the transmitter expects periodic 
acknowledgement from the receiver (every quarter-window or 512 bytes).    The 
transmitter may hold up transmission, if necessary, to stay no more than 2048 bytes 
ahead of those acknowledgements.    



Kermit / Super Kermit
Developed at Columbia University for mainframe-to-microcomputer communications, 
Kermit is the lingua franca of file transfer protocols: practically every operating 
system has an implementation of Kermit.    Like ZMODEM, Kermit is a streaming 
protocol with sliding windows.    Error recovery specifically targets the bad packets 
and does not retry good packets that were received later than the bad one.    

Kermit can operate with or without byte parity.    This makes it especially useful when 
communicating with systems which reckon bytes as 7 bits instead of 8 bits (this 
includes most packet-switching networks and many non-DOS computers).    

Still, when transferring from one DOS/Windows PC to another via modem, ZMODEM is
the most efficient terminal-mode protocol so far.    

Data Compression and Error Correction
Most modern modems compress data before transmitting it to the receiving modem 
(see DTE/DCE segment) where it's uncompressed.    Modern file transfer protocols 
such as ZMODEM and Kermit expect data compression and take maximum advantage
of it.    

XMODEM, YMODEM, and other nonstreaming protocols, however, often slow down 
when data compression and error correction are present.    This is because the 
turnaround delay is longer while the modem tries to figure out how to packetize and 
compress data.    Especially at higher baud rates, any time saved transferring each 
block is lost while the sender waits for acknowledgement.    



Upload using a file transfer protocol

Which file on your PC do you wish to send to this terminal-mode BBS?    

To reach this window, from the Terminal Mode window's File menu, select Upload.    

File Name
The text box lets you manually enter the drive:\directory\...\filename.ext of the file 
which you wish to upload to the BBS.    

The standard list box below the text box displays all files in the current drive:\
directory which are of the type selected by List Files of Type.    

The fastest way to select a file, once it's visible in the list box, is to double-click it.    

List Files of Type
The dropdown list box lets you limit the files displayed under File Name to those of a 
particular type.    This is helpful when a directory on your PC has dozens of files but 
only a handful of the type you wish to upload.    If List Files of Type doesn't offer the 
filter you require, you can manually enter your own under File Name.    

For example:

° Text files are often *.txt.
° Word processor documents are often 

*.doc.
° DOS Batch files are *.bat.    
° Programs are either *.com (command) or 

*.exe (executable).    
° Common Windows graphics formats are 

*.bmp (bitmap) and *.wmf (metafile), 
although there are more than a dozen 
other popular graphics formats.    

° Files are often compressed and packaged 
into a single file for quicker and simpler 
delivery.    Such compressed packages are 
most commonly stored as *.zip (PKware 
format).    In order to create a zip file, you 
need the program PKZIP.EXE.    

Other forms of data will come with extensions appropriate to them.    The normal 
default is to *.* for all files.    

Directories
The list box displays the directory tree of the drive:\ selected below in Drives.    The 
current directory is the one whose folder icon is open and darkened within.    Any 
folders listed below it are children subdirectories of the current directory.    Any folders
listed above it are parent directories.    Between the list box and the title line 
Directories: you will see displayed in text the current directory's drive:\path, 
possibly abbreviated.    



Double-click on a directory to switch to it.    If the directory you seek is not visible, 
double-click on the directory which you know to be its parent.    This list box does not 
display the entire tree at once, but limits itself instead to the parentage and children 
of the current directory.    

Drives
This dropdown list box selects the drive letter you wish displayed.    Depending on 
your PC's setup, it may display volume names in [brackets] to the right of each drive 
letter.    

A single click selects a drive letter.    The Directories and File Name list boxes will 
change to display the new drive's current directory and files.    

Protocol
This button lets you select which terminal-mode file transfer protocol you wish to use 
when uploading the file from your PC to the BBS PC.    



Terminal Mode Options Menu

Download Protocol
Select the file transfer protocol you prefer when receiving files from a terminal-mode 
BBS.    

Upload Protocol
Select the file transfer protocol you prefer when sending files to a terminal-mode 
BBS.    

Auto-Sense Client/Server
Some online services operate as gateways, allowing you to dial out through them to 
other online services.    Even though the service you're currently in contact with runs 
in terminal mode, one you dial out to may be a Worldgroup supporting C/S mode.    

If you select this option (place a check beside it), WGM will connect to such services 
in C/S mode.    

If you deselect this option (remove the check beside it), WGM will connect to such 
services in terminal mode.    

Doorway Mode
Doors are DOS programs running on a PC at the online service's office which you can 
use as if they were running on your PC.    Some Door programs expect to receive 
function keystrokes (F1 through F10, Shift+F3, etc.).    

If you select this option (place a check beside it), WGM will send to the online service 
all keycodes for any keys you press while the Terminal Mode window is the active 
window.    For example, ALT+F4 will not close the Terminal Mode window.    Instead, the
keycodes which describe that combination will be sent to the online service.    

If you deselect this option (remove the check beside it), WGM will intercept all 
function keystrokes and attempt to act on them itself.    For example, ALT+F4 will 
close the Terminal Mode window.    

Autostart Zmodem Downloads
Because the ZMODEM file transfer protocol conveys the filename.ext as well as the 
contents of a file, you can automate the process of receiving a file from a terminal-
mode BBS.    

If you select this option (place a check beside it), WGM will immediately begin 
downloading a file to the last chosen drive:\directory on your PC as soon as it 
receives a ZMODEM downloading signal from the BBS.    

If you deselect this option (remove the check beside it), you must manually select 
Download from the Terminal Mode window's File menu and approve a drive:\directory 
to receive the file.    

If you select any file transfer protocol except ZMODEM, this option will have no effect.
You must manually control the transfer in those cases.    

Resume Zmodem Downloads
Another valuable feature of ZMODEM is the ability to pick up where it left off following



an interrupted download.    This is especially welcome when you're on the 27th 
minute of a 30 minute download when the connection breaks.    

If you select this option (place a check beside it), WGM will tell the BBS what portion 
of the file it already has, and will resume at the break point.    

If you deselect this option (remove the check beside it), the transfer will begin again 
from the first byte.    

Enlarge Font
Reduce Font

The terminal mode window can be displayed in any of three sizes.    These commands
enlarge and reduce the terminal mode window one size at a time.    

You'll know you've reached the largest choice when the Enlarge Font selection is dim, 
and similarly you'll know you've reached the smallest choice when the Reduce Font 
selection is dim.    



Connection Status Window

This displays the current status of the connection between your PC and the online service.    
It also lets you manually break or remake the connection.    

To bring up this window, from any group within WGM, open any online service item (double-
click any icon).    

Online/Offline
##:##

This shows whether you are currently online or offline    

and tracks your time online.    When you first go on deck, but not online, the indicator 
will read 00:00.    If you go from being online to being on deck, the readout will show 
the amount of time you've accumulated online so far (in the same manner as a 
stopwatch).    

TXD and RXD
These indicators let you know when there's activity on the connection between your 
PC and the online service, and in which direction the activity is travelling.    

The Transmit indicator lights whenever your PC sends data to the online service.    It's 
comparable to the TXD indicator light on external modems.    

The Receive indicator lights whenever the online service sends data to your PC.    It's 
comparable to the RXD indicator light on external modems.    

Status box
This displays the most recent of several dozen status messages.    

 or 

Gives you manual control over the connection between your PC and the online 
service.    The graphic tells you the current status of the connection (plugged in 
means connected and unplugged means not connected) while the word beneath the 
graphic tells you what will happen if you click the button.    

A number of activities within WGM can be performed on deck while disconnected 
from the Worldgroup server.    While you're performing one of those activities, you 
may select an action which requires assistance from the Worldgroup server.    WGM 
will attempt to connect in order to carry out your request.    If you do not wish to 
connect at that moment, click this button, now marked Disconnect, and the attempt 
to connect will stop.    
 



Glossary

The following definitions are available:

Bitmap File
C/S (Client/Server) Mode
Client Side
Dumb Terminal
File Transfer Protocol
Metafile
Online, Offline, On Deck
Password
Worldgroup server
Server Side
Sysop
Terminal Mode
User Account
User-ID



Bitmap File
A bitmap is a way to store a graphical image as a rectangular grid of dots (pixels).    

    For example, the icon for Windows' Control Panel is a bitmap.    

Here it is again 4 times as 
large.    Bitmaps don't enlarge 
very well because the 
information that is stored 
within them is only accurate 
down to the size of a single 
pixel (dot).    Enlarge a bitmap 
and you get big dots.      

On the other hand, bitmaps work very well when they store information which is not meant 
to be enlarged, reshaped or otherwise manipulated.    Windows icons are bitmaps (stored as
.ico files or embedded in .exe files).    Windows wallpaper designs are bitmaps (.bmp).    

The Windows program Paintbrush can manipulate .bmp files.    

See also Metafile.    



C/S (Client/Server) Mode

Two-sided computing: your PC and the Worldgroup server PC both work to satisfy your 
requests.    Your PC's processing power is not ignored (as with a terminal mode BBS).    In fact,
your PC ends up doing most of the work.    C/S mode minimizes wasted time online by letting
you do many tasks on deck.    

Client/server means that one program (the client) can ask another program (the server) for 
assistance.    The two programs often run on separate computers connected by a 
communications link (a network, the telephone system, etc.).    

WGM is a client program running on your PC.    

Worldgroup is a server program running on a remote PC.    



Client side
Your PC running WGM is the client side of a client/server relationship.    The remote PC 
running Worldgroup is the server side of the relationship.    The term client side includes:

1) any programs which run on your PC
2) any data, documents, or other files which are stored on your PC

The client side can do many tasks itself, and calls on the server side for tasks it cannot do 
(exchanging messages with other clients, looking up centralized information, etc.).    



Dumb Terminal
A device which has a keyboard, a 
monitor, possibly a mouse, but has 
no ability to process data by itself.    
A dumb terminal has to be 
connected to a computer in order to
do anything.    

Old-style user-side modem programs are known as 
terminal programs because they make your PC mimic 
a dumb terminal (thereby wasting your PC's processing
power).    

File Transfer Protocol
A language for exchanging files between two computers and confirming that what arrives is 
the same as what was sent.    Common protocols for terminal-mode transfers include 
ZMODEM, XMODEM, YMODEM-Batch, and Kermit.    

WGM in C/S mode uses its own information transfer protocol, GCSP, which uses Dynapaks to 
exchange all forms of data including files.    



Metafile
A metafile is a way to store a graphical image as a collection of shapes, angles, and relative 
distances.    

    For example, this drawing of a telephone plug is a metafile.    

Here it is again 4 times 
as large.    Note that 
you can see more 
detail in the enlarged 
version.    Stretched 
large or small, a 
metafile is recalculated
to provide the most 
accurate image 
possible.    

Because PC monitors in use today may be set to any of a dozen different resolutions (so 
many pixels tall, so many pixels wide), we have used metafiles within WGM's help files 
wherever possible.    This makes it more likely that graphics will appear properly on your 
display.    

The Windows program Paintbrush cannot manipulate .wmf files.    

See also Bitmap File.    



Online
Connected.    
Your PC is online whenever it is connected to a Worldgroup server.    

Offline
Disconnected.    
Your PC is offline whenever it is not connected to a Worldgroup server.    

On Deck
Disconnected but able to perform tasks.    
Your PC is on deck whenever WGM is running the client-side program (E-mail, File 
Libraries, etc.) for a Worldgroup service but your PC is not yet connected to the online
service.    



Password
The private half of your identification, seen only by the software and the Sysop.    

A password is the confirmation that you are who your User-ID says you are.    Without 
passwords, someone else could log on using your User-ID and do things that you would be 
blamed for.    Keep your password secret.    

Avoid obvious, easily guessed, passwords.    Make up something that is not your mother's 
maiden name, not your job title, in fact not anything related to your work.    

Don't use a completely random string of characters, though.    "NE1410S" will be hard to 
remember.    Instead, an effective middle choice is to run two words together which are 
easily remembered by you but not easily guessed by others.    "Twosun" for example.    



Worldgroup server
An online service running Worldgroup server software by Galacticomm, Inc.    

Online services running other software, including Galacticomm's The Major BBS 
(Worldgroup's predecessor), are not servers in the client/server sense.    WGM drops back to 
terminal mode in order to communicate with them.    



Server side
The remote PC running Worldgroup is the server side of a client/server relationship.    Your PC
is the client side of the relationship.    The term server side includes:

1) any programs which run on the Worldgroup server PC
2) any data, documents, or other files which are stored on the Worldgroup server PC

The server side exists solely to do tasks which the client side cannot do itself (exchanging 
messages with other clients, looking up centralized information, etc.).    



Sysop
A System Operator, or Sysop, is the manager of an online service.    



Terminal Mode
One-sided computing: the software running on the remote computer insists on doing all of 
the work, so your own PC might as well be a "dumb terminal."    This mindset made sense 
when computing power was prohibitively expensive and terminals were cheap.    Today, 
though, your PC may well be more powerful than the PC running the online service you call.   
Even if it isn't, your PC is closer to you than the service's PC.    It can do things without delay,
if the software at both ends permits.    Client/server mode permits this.    Terminal mode does 
not.    

WGM falls back from C/S mode to terminal mode in order to communicate with BBSes and 
other non-Worldgroup online services.    



User Account
A list of information including your full name, your mailing address, your telephone number, 
etc.    In a for-profit online service, the user account may include your credit card number or 
other method of payment.    

User account information is private, seen only by you and by the Sysop.    

Your user account is identified by your User-ID and password.    



User-ID
The public half of your identification, seen by the software and by other users.    

A User-ID is a string of 3 to 29 characters (although some systems may limit you to fewer 
than 29).    On business systems, your User-ID is often your full name.    On social systems, it 
is often a nickname or "handle."    In some situations, a User-ID may be assigned to you.    In 
other situations, the choice is yours.    

Your User-ID is verified by the password you associate with it.    



      I never metafile I didn't like
            (Stryker said I could do it! --Marc)
 




